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Essential Features of Excel

Abstract
This article assumes that you are familiar with the GUI of a modern spreadsheet – selecting, dragging and so
on. But we expect that 100% of readers are in that category – certainly most students in today’s classroom are
fully conversant with how such programs work. What you may not be so familiar with are the essential
features of Excel that make it such a usable program. We hope that you do find some surprises in what follows
and that you will make these features a regular part of the way in which you use Excel.
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1. Introduction 
This article assumes that you are familiar with the user interface of a modern 

spreadsheet
1
 – selecting, dragging and so on. But we expect that 100% of readers 

are in that category – certainly most students in today’s classroom are fully 

conversant with this kind of interface. What you may not be so familiar with are 

the certain features of Excel that we consider to be essential to its use in the 

educational contexts. We hope that you do find some surprises in what follows 

and that you will make these features a regular part of the way in which you use 

Excel in the classroom. 

2. The Fill Handle 
Suppose we want to quickly create a 1 – 100 square or 100 board (Figure 1). A 

completed version of the table is given in the first worksheet of associated file 

Excel Essentials.xlsx. 

The first step is to enter a 1 in the top left corner. Please read the following 

statement as “select cell B2 and type 1”. 

(B2) 1 

Move the cursor to the small square at the bottom right corner of the cell 

which is called the fill handle. When you hover over the fill handle, the cursor 

will turn into a + sign. Press <Control> and a second, much smaller + sign 

appears (see Figure 2). 

                                                 
1
 This paper describes the chosen features in terms of Excel 2010 and the diagrams were 

prepared using that version. But the features were present in earlier versions of Excel and can be 

implemented in very similar ways in those earlier versions. 
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Figure 1: A 100-square 

 

The small square 

on the boundary of a 

selected cell is called 

the fill handle 

As the mouse 

moves over the fill 

handle it changes to a 

+ sign 

Press  <Control> and 

 a second + sign appears 

   
 

Figure 2: The Fill Handle 

 

Move the mouse to the fill handle of B2 and hold down <Ctrl> while you drag 

down to cell B11. This action will enter the numbers 1, 2, 3, …, 10 the first 

column of the table. In another part of the worksheet, try this with starting cells 

that have values like Jan, Monday, Item 1, 1st, … and so on. This will soon give 

you a feel for the usefulness of the fill handle
2
. 

To make the rest of the table, start the next column with: 

                                                 
2
 Some of the lhe lists that the fill handle creates are contained in Custom Lists. In the File 

tab, choose Options and select Popular. Click the Custom Lists button to see what is available by 

default. This is also the place to add other lists, such as A, B, C, … that the fill handle can use 

subsequently. 
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(C2) = B2 + 10  (read this as “Select C2 and type  = B2 + 10) 

Drag the fill handle of C2 across to K2 in order to complete the top row of the 

table. You can click on some of the cells between C2 and K2 to see what the 

formula has been turned into by the fill handle. Finally, select K2 and double click 

the fill handle. The required formulas are copied down as far as the data in the 

adjoining column, Column B. More advanced uses of the fill handle to create data 

tables are given in by Abramovich and Eun [1].  

Using the fill handle to extend a formula across and/or down a page and to 

auto-fill a formula are big time savers – well worth mastering. Here’s another use. 

Select the range B1:K1 and with the fill handle of K1, drag down to 

K12. 

When you release the mouse button you have deleted the table. Don’t press 

<Control><Z> to undo that outcome; make the table again from the start. It’s 

good practice! 

3. Conditional formatting and much more 
I will always remember the wonderment I experienced when Stephen Sugden 

(Bond University) showed me the following example. It refers to taxi numbers, so 

named by G. Hardy because of a comment made by S. Ramanujan his protégé 

from India. For details of the story see Abramovich and Sugden [2], where many 

examples of conditional formatting are described. 

The table in the Taxi Number worksheet is close to complete. When making 

it, we used: 

1. The fill handle with <Control> was used to insert the numbers 1 – 30 into 

C2:AF2. 

2. That range was copied and B3 was selected. Paste:Transpose was then 

used to add the same list to B3:B32. 

3. Click on the  number for Row 2 to see the Name Box change to x and on 

label for Column B see the Name Box change to y. This sets us up for the 

next step. 

4. The formula in C3 is (C3) = x^3 + y^3 and it is this formula that was 

added to the rest of the cells of the table using the fill handle. 
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Figure 3: Applying Conditional Formatting. 

As a small aside, it seems to us that one of the most useless statistical features 

of data that we learned at school was to find the MODE of a data set. It has little, 

if any, statistical significance, just one of those things we were asked to do, but 

with no serious rationale ever being provided. Thanks goodness that the creators 

of Excel chose to include it, because there are times when it is really useful – but 

not for statistical purposes. 

5. In cell A1 the MODE function is used to find where in the table taxi 

numbers occur. Click on A1 to see the formula (A1) = MODE(C3:AF32). 

6. We then applied conditional formatting to the table to find where those 

taxi numbers reside. The conditional formatting shown in Figure 3 is 

saying “Highlight the cell if is has the same value as the MODE function 

found”. 

As it stands, the worksheet fully justifies Ramanujan’s statement that the 

number 1789 is indeed quite a remarkable number. It is the smallest number that 

can be formed as the sum of two cubes, in this case as 1
3
 + 12

3
 and as 9

3
 + 10

3
. 

The MODE function has showed us the first number that occurs four times in 

the table. If you would like to find the next taxi number, simply delete one of the 

instances of 1789. You will find that just by making a table with numbers 1 – 30, 

we can find quite a few taxi numbers. 

Please bear in mind that the taxi number example was no more than a vehicle 

for showing that: 

Names can be applied to whole columns to make the formulas in a table 

very easy to follow. 

The fill handle makes it very quick to generate a table of values. 

The MODE function can be used to pick out the most frequently occurring 

value within a jungle of numbers. But it is most powerful when used in 

conjunction with Conditional Formatting. 

As an extension of this, we can remove duplicates from the table by only 

showing �� �  �� when � � �. We can also introduce a scrollbar that will allow 
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us to gradually grow the table, in this way ensuring that the lowest repeated 

number occurs within the table will be found. The worksheet labelled Taxi 

Numbers (2) has a scrollbar that controls the value of a cell called show_value 

and the worksheet has the following formula in C4: 

(C4) =IF(AND(x >=y, x + y <= show_value), x^3 + y^3, "")  

The formula in C4 has been spread across and down the full table using the 

fill handle. You can also change the formula in C4 to find the sum �� �  ��. What 

is the smallest number that can be expressed as the sum of two square numbers in 

two different ways, even three different ways? 

The use of names, the fill handle and conditional formatting really are 

essential features of Excel. The other features that we want to point out are more 

complex in that they show how we can make Excel create two types of chart that 

are very popular in the school curriculum, but which Excel does not make 

directly. 

4. How to make a Histogram 
Of all charts that we teach in schools, none is more widely used than the 

histogram. Indeed, from the point of view of statistics education, it would be hard 

to pick a chart type that is more used for univariate data. What a surprise, then, to 

find that Excel has no built-in histogram chart type and that the histogram add-on 

has severe limitations because changes to the data are not reflected in the chart. 

So, there is no alternative but to know how to build your own histogram.  

First, let’s look at some of the features of a histogram that are important (see 

Figure 4). 

The data is counted in intervals. If the histogram add-on is used, the intervals 

have to be chosen before the chart is created, but the size should be chosen to 

make the trend of the data visible. If the interval size is too small or too large, the 

trend may not be visible. Ideally, once our data is given we should be able to vary 

the interval size
3
. 

The bars of the chart should touch, and in Excel Column Charts, the bars are 

by default separated. Also, it would be good if the labels changed with interval 

size. 

                                                 
3
 We do seem to remember a time when the intervals of a histogram were allowed to be of 

different sizes and the area of the bar showed the information, not its height. It seems that we can 

only work with intervals of a fixed size but that is probably a good thing. 
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Figure 4: A typical histogram 

These are just some of the features that Excel does not do, unless, that is, you 

show it how. 

Using Names 
To make Excel create a histogram it is good to build on its strengths. We will 

suppose that the data that we want to chart (say 100 data points) is held in a 10 by 

10 array of cells. The first thing to do is to name that array as data. Our data is in 

B3:J12, so we selected that range, clicked in the Name Box and typed data 

followed by the <Enter> key (see Figure 5). 

Adding a Scrollbar 
We need to be able to experiment with the interval size to find which one is the 

most appropriate. As the diagram below shows, we highlighted D14 and attached 

a scrollbar (Form Control
4
) to change its value. Although it doesn’t show, we 

have also named D14 as size (see Figure 6). 

                                                 
4
 There are two types of scrollbar but the one that we find useful is the Form Control not the 

ActiveX Control. To set the properties of the latter, you need to be familiar with VBA and not 

many students will have met VBA yet. 
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Figure 5

Because we use the scrollba

scrollbar icon to the Quick Access section of the screen.  

File tab and you can customise it by choosing Options in the File tab menu. It

fiddly, but once done, it doesn’t need to be redone. Learning how to set the 

parameters of the scrollbar

students really appreciate being able to make their

controlling cell values with it.

Using the INT function
There are a few functions in Excel that we find very useful,

never used them in other contexts, and the INT function is one. To find the 

interval into which each data item should be put, we use the formula:

 (B16) = size*INT(B2/size)

Figure 5: Data to be shown in a histogram 

 

Figure 6: Creating the Interval Data 

Because we use the scrollbar so frequently (see also Staples [xx]), we a

bar icon to the Quick Access section of the screen.  This is the part above the 

you can customise it by choosing Options in the File tab menu. It

fiddly, but once done, it doesn’t need to be redone. Learning how to set the 

scrollbar is important too and once mastered, we find that 

students really appreciate being able to make their spreadsheets interactive by 

controlling cell values with it. 

Using the INT function 
There are a few functions in Excel that we find very useful, even though we have 

never used them in other contexts, and the INT function is one. To find the 

interval into which each data item should be put, we use the formula: 

(B16) = size*INT(B2/size) 

 

 

, we add the 

This is the part above the 

you can customise it by choosing Options in the File tab menu. It is 

fiddly, but once done, it doesn’t need to be redone. Learning how to set the 

we find that 

spreadsheets interactive by 

even though we have 

never used them in other contexts, and the INT function is one. To find the 
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This formula, which can be applied equally well to non-integer data, can be 

spread over the range B16:K25 in order to generate a table in which the end-point 

of the interval in which each of our data points will lie. To do this efficiently, 

means that you should use the fill handle to drag the formula across from B16 to 

K16 and then down to K25. It is also a good idea to name the B16:K25 range; we 

chose interval_data. You can experiment by changing the scrollbar that controls 

size and see how the numbers in the interval_data cells change accordingly. 

Using the COUNTIF function 
We are now ready to create the data for the histogram. One of the Excel functions 

that we use perhaps as often as any other is COUNTIF, and it makes it easy to 

generate the data needed for the histogram. The data will start in M3 and continue 

down column M. The formulae at first are: 

 (M3) = 0 
 (M4) = M3 + size 

Drag this formula down to M22 and name the range M3:M22 as intervals. 

Now go to N3 and enter the formula: 

 (N3) = COUNTIF(interval_data, intervals) 

Double click the fill handle to fill this formula down to N22. 

By taking the range of intervals down to M22 we have catered for the case 

when the interval size is at its minimum of 5. But when the size is set to, say, 10, 

much of the range is filled with interval numbers that are out of the range of the 

data. Our work-around for this involved not filling cells that are not needed. We 

made the following changes to M4 and N4 and filled down. 

 (M4) = IF(M3 < 100, M3 + size, "") 
 (N4) = IF(M4 <> "",COUNTIF(interval_data,intervals),"") 

As before, change the scrollbar to see how the information in M3:N22 

changes accordingly. 

Making the Histogram 
The following steps will make the histogram in a reasonably efficient way – there 

are many different ways in which to do this but this one uses some important 

features. 

Select only the data in column N (N3:N22) and in the Insert Tab, choose the 

first Column Chart option. Select the Design Tab and from the Chart Layouts 
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menu choose Layout 8. This is the one that most readily represents a histogram 

because the Gap Width has been set to 0. 

The axis labels need to be made to match the information in column M. Right 

click the chart and choose Select Data … This allows you to Edit the Horizontal 

(Category) Axis Labels. Click the Edit button and drag over M3:M22 to select the 

axis labels. 

We also need to put meaningful information into the chart title and axis titles. 

Here is a way of making these titles change as the scrollbar changes size. For 

example, to link the Chart Title to the value of a cell, add the following formula to 

cell P3. 

 (P3) = "Histogram in Intervals of "& size 

Now click on the Chart Title to select it and in the formula bar add: 

 = P3 

The axis titles can be linked to P4 and P5 in the same way. 

You can also create your own interval labels in Column O with a formula 

such as: 

 (O3) =IF(M3 <> "",  M2 & "- "& (M3- 1), "") 

To add these labels to the chart, right click the chart, choose Select Data …  

and edit the Horizontal (Category) Axis Labels. 

Finally, have a go and experiment with the scrollbar to find an appropriate 

size for the histogram intervals. Do you agree with us that an interval size of 14 

gives quite a meaningful shape – it also accords with some advice we seem to 

remember that there should be about 7 intervals in a histogram. 

5. How to make EDA-type charts 

The Box and Whisker Chart 
This is probably not the place to argue against the introduction of EDA, 

exploratory data analysis, techniques to the school curriculum, see [4], [5] and [6]. 

Rarely do we see EDA techniques finding application outside the classroom, but 

they have nevertheless been embraced by the educational community as being a 

good way to engage students with statistical information. Perhaps because so few 
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people use the techniques outside the education sector, there is no Box and 

Whisker option in Excel, but it does have a chart type that comes close enough. 

 

In the Other Charts option, the second Stock option is the one used for the 

above chart.  

Random data generated using the RANDBETWEEN (bottom, top) function has 

been placed in columns B and C and the ranges labeled as data1 and data2.  

While creating what follows, we copied and used Paste:Values  to stop the data 

from changing on us all the time. The last step in completing the worksheet was to 

restore the RANDBETWEEN function so that the F9 (calculate now) feature 

could be used to see the chart in action. 

To create a box and whisker chart, you have to divide the data into four 

quartiles, which, when working by hand, means that the data first has to be sorted 

before you can locate these values. With Excel, no sorting is needed. And the 

MEDIAN function is really quite versatile when it comes to finding the quartile 

values. The first step is to find the medians of the data sets. 

(J6) = MEDIAN(data1) 

(J7) = MEDIAN(data2) 

We then need to find the maximum and minimum values for each data set 

(see the formulas in G6:H7). To find the first and third quartile numbers requires 

the use of an array function, and that in turn requires that you know how to enter 

formulas that refer to ranges of cells. It is done by holding down <Control> and 
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<Shift> while you press <Enter>. With that in mind, we can find the Q1 value by 
finding the median of all those values that are less than or equal to the dataset 
median. 

(F6) =MEDIAN(IF(data1<=$J$6,data1,"")) and <Control><Shift><Enter> 

(F7) =MEDIAN(IF(data2<=$J$76,data2,"")) and <Control><Shift><Enter> 

The formulas in I6 and I7 are very similar with the <= replaced by >=. 

If you are wondering why the information in F5:I7 has been set out in that 

way, it is because the Stock Chart requires that you position the data in the order 

Open-Hi-Lo-Close. It is those values are used to create the boxes and whiskers of 

the resulting chart. 

To make the chart, select the range F5:I7 and insert the Other Charts:Stock 

chart. Much of the work is now complete, but we felt that it would be good to add 

in the other important information about the data sets. In N5 we created the 

sentence: 

(N5) = "Median = " & J6 

The cells below that hold the other sentences that we would like to add to the 

chart. Using the Insert:Shapes:Text Box, we made sure that the empty text box 

was selected and then, in the Formula Bar, we add the reference: 

= $J$6 

In this way, we can control the content of a text box to match the current 

values in the worksheet. Our last step was to return the data set to use the 

RANDBETWEEN function and now the chart reacts to each press of the F9 key. 

It appears that the Stock graph will not allow you to swap the x- and y-axes in 

order to display the box and whisker diagrams in the usual orientation. Is that such 

a loss? We think not. 
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Back to Back Plots 
In contrast to the histogram and box and whisker charts, Excel does generate one 

of the EDA basics, the stem and leaf plots, without any help from you. They are 

standard bar charts. Excel also makes back-to-back plots easy to generate. 

 

In the example above, monthly Max and Min temperature data has been 

plotted as a 2-D Stacked bar, but the Min temperatures were converted to negative 

numbers before plotting. By changing the Number Format of the horizontal axis 

to show negative numbers in red, the horizontal axis labels do not display an 

accompanying – sign, and the change in colour is hardly noticeable. 

6. In Conclusion 
While we might want to spend time showing students how to navigate a 

spreadsheet and enter numbers into cells, those are skills that we believe cause no 

difficulties. But to release them to become skilled spreadsheet users, we need to 

look beyond the basics and to share some of the features of Excel that are 

essential to making use of its power. We have chosen the fill handle, conditional 

formatting, the use of names and scrollbars as being the most important. We have 

also included the INT, COUNTIF and MODE functions as having valuable uses 

and we have shown how to make the two types of chart that are most frequently in 
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educational contexts. By introducing the scrollbar (Form Control) and a method 

of making chart titles and text boxes respond to worksheet changes, we have 

pointed to two very useful devices for making spreadsheets interactive. By 

touching on the need to use <Control><Shift><Enter> with array formulas we 

may have stepped slightly outside the junior-high school boundaries. But it is a 

feature that is essential in many applications and we are comfortable about 

including it. It is our opinion that these features are not ‘icing on the cake’, rather 

they are essential to the effective use of Excel. 
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